
SOLAR
LASER SYSTEMS LTD.

CorelDRAW: The basics
Overview

01634 290260
www.solarlasers.co.uk

There are many computer applications that you can use to drive a laser cutter. CorelDRAW is the most 
versatile and mastery of it will allow you to achieve the outstanding results from your laser system. 
CorelDRAW is a very powerful professional vector graphics package usually sold with other Corel 
products such as CorelTRACE and Corel PHOTO-PAINT. Some features will be familiar to those 
provided in similar applications such as Adobe Illustrator. CorelDRAW supports Windows shortcuts and 
is both configured with it's own additional shortcuts and can be customised to have additional shortcuts 
added. It has a vast array of import and export filters to allow you to work successfully with the majority 
of other applications you will encounter. Another advantage to be gained from using CorelDRAW is that it 
can be used to great benefit for a multitude of other tasks Teachers encounter in their day to day work. 
This manual for example has been produced in CorelDRAW.

Learning how CorelDRAW treats the various objects you create and import is an essential element of 
your training. A glossary of CorelDRAW terminology is provided with this material and you can find 
further explanations in the Help screens.

To begin this tutorial, let's take a look around the workspace. CorelDRAW has gone through many 
updates over the years and earlier versions will have some of the features located in different places to 
those described in this manual, however since Version 9 most of these have been standardised. 



The Workspace

If you are entirely new to CorelDRAW or maybe you haven’t had much opportunity to use it in the past he first thing 
to do is to familiarise yourself with the workspace.

At the top of the screen you will find the Menu Bar. The Menus contain a wide variety of commands to modify the 
characteristics of your workspace and the entities within it.

Beneath the Menu Bar you will find the property bar. This is adaptive dependent on the object you select or the tool 
you are using and you should note the various options you can control with each tool you use or shape you create.

On the left-hand side of the screen is the toolbox you use to create shapes and text with. At the bottom of the 
screen is the Status bar. This will tell you important details about the objects you select and is an invaluable guide 
to resolving problems.

A number of Dockers are available to allow you to manage your drawings and modify the components you create. A 
Docker is a toolbar that can be opened and closed as you wish and either kept floating or docked at the side of 
your workspace and collapsed to allow you greater screen space. I always have the following dockers open: Object 
properties, Transformations, Shaping. I frequently open the Object Manager and Undo Docker for advanced control 
of my drawing.

Menu Bar
Property Bar

Toolbox

Colour Palettes

Dockers

Status Bar

Page

Rulers



Configuring the Workspace

Defining the Page Size
You can create your drawings in any page size you find convenient however it is very important that when 
you print your file to the laser cutter that the page you print from represents the bed size of your machine. 
If it doesn't you will have no control over where the file is being cut.

The page size can be set on the Property Bar:

The rulers on your laser cutter 
have their origin at the top left-
hand corner and you will find it 
useful if your CorelDRAW page 
has the same. This can be defined 
by double-clicking on the rulers 
and entering the value you set the 
page height to in the Vertical 
Origin. Note it is easier to keep the 
units in Inches when you do this. 

VL200 16” x 12”
VL300 24” x 12”
M-300 24” x 12”
M-360 24” x 12”
V-460 24” x 18”
X-660 32” x 18”

VLS2.30 16” x 12”
VLS3.500 24” x 12”
PLS3.60 24” x 12”
PLS4.60 24” x 18”
PLS6.60 24” x 18”

Nudge Keys
The Nudge Keys allow you to 
make quick precise incremental 
adjustments to the position of 
selected objects. Select objects 
and use the arrow keys on your 
keyboard to move them.

A Nudge is a movement by a 
defined amount. Double-clicking 
on the rulers opens the ruler options dialogue where the nudge amount can be defined. I recommend a value 
of 1mm is entered.

You will also see options for Super Nudge and Micro Nudge. These will move a selection by a multiple of the 
Nudge value you defined. I recommend for practical purposes you set the Super Nudge to 10 and the Micro 
nudge to 2. A  Super Nudge will then be 10mm and a Micro nudge will be 0.5mm.

 Depending on the version of CorelDRAW you have this can be set in the Property Bar when nothing is 
selected by entering a value in: 

Note that the Super Nudge and the Micro Nudge factors cannot be set in the Property Bar and will be 
whatever factor has been defined in the ruler options.

To use Super Nudge, hold down the Shift key as you press the arrow keys.

To use Micro Nudge, hold down the Ctrl key as you press the arrow keys.

As the bed of your Universal laser cutter has been built to 
Imperial measurements, you may find it simpler to set the 
Units to Inches first before entering the dimensions. These 
are the actual dimensions depending on the model you 
have.

1.0 mm



The Toolbox

Take a tour of the Toolbox. By default this resides on the left hand side of the screen but it can be moved anywhere 
else, sometimes inadvertently, particularly if you use a laptop computer with a touch mousepad!

Select Tool

Shape / Knife Tool

Zoom Tool

Freehand Tool

Smart Drawing Tool

Rectangle Tool

Elipise Tool

Polygon /Graph / Spiral Tool

Basic Shapes Tool

Text Tool

Blend / Contour  Tool

Eyedropper Tool

Outline Tool

Fill Tool

Interactive Fill Tool

Note the small triangle 
in the corner of some 
tools. Clicking on this 
opens a flyout with 
other related tools.



Drawing Basics

Drawing with CorelDRAW is best achieved by 
breaking the items you are creating down into a 
series of discrete components that are then sized 
using the Transformation Docker and shaped with 
the shape tool and the Weld and Trim tools in the 
Shaping Docker.

There are 4 basic tools used to create shapes:
Freehand Tool
Rectangle Tool
Ellipse Tool
Polygon Tool

Select any one of 
these tools and 
click and drag your 
mouse to draw. 

 
When using 

the Freehand Tool to 
draw a straight line you 
need to click, then move 

the mouse without dragging 
then click again. Holding down 
the Ctrl Key as you do this will 
constrain the line you draw to 

be horizontal, vertical or at 
15 degree snaps 

between.    

 Holding down the Ctrl key when drawing 
the other shapes will constrain the shape 
to be regularly proportioned, i.e.  
rectangles becomes a squares, an ellipse 
becomes a circle and a polygon has 
identical sides.

Click and Drag

Click, take finger off mouse button,
move mouse then click again.

Holding down the Ctrl key
as you do this

Click and Drag

Holding down
the Ctrl key

as you
click and drag

The rectangle and polygon objects 
you draw can be modified in these 
ways: You can radius the corners 
of a rectangle and you can turn a 
polygon into a star shape. If you 
select the shape you will see 
control points where the lines 
connect and at the mid point of 
the polygon lines. Using the 
Shape Tool, click and drag these. 

Control Points



Dockers

A Docker is a type of dialogue box that can reside on the screen to allow you quick access 
to commands, provide information about your work, to allow you to modify your work, to 
control your drawing in many ways.

There are a number of dockers that you may choose to keep open at all times. They can be 
minimized to keep your workspace as large as possible but are readily accessible, and can 
be closed down if you don't use them very frequently.

Dockers that are particularly useful and worth keeping open all the time are: the Object 
Properties Docker; the Transformation Docker; the Shaping Docker; the Undo Docker and 
the Object Manager Docker.

Dockers are opened through the Window drop-down menu.

Minimize Expand by clicking 
here or on the tab for 
the Docker you want 
to use.

Dockers stack over 
each other as you 
open them



The Transformation Docker

The Transformation Docker enables us to modify the objects we create or import in a precision way. We 
can move objects to a precise location, rotate, mirror, size and skew accurately.

Position
Rotate

Scale and Mirror

Size

Skew

Anchor point



The Shaping Docker

The Shaping Docker lets you achieve the following things; 
Weld, Trim and Intersect. Late versions of CorelDRAW have
added more functions to the shaping Docker that advanced users
may find useful but of all the functions Weld and Trim will be found
to be powerful tools that are the most useful.
In each function you are given the option to leave the original Source object
and/or Target object. Checking these tick-boxes when you use these functions
will create duplicate objects. This is useful for advanced users with good
planning skills and enables better productivity.
It is advised that you leave these tick-boxes unchecked until you are fluent
with using the Shaping tools.

The Source Object is the object you originally select to weld or trim.
The Target Object is the object you subsequently act upon.

It is important to understand that using these tools will affect the properties of
the objects you are working with. The source object will take on the properties
of the target object.

The best way to understand how these tools are used is by example.

Weld.
Draw a rectangle. Now draw a second rectangle that overlaps the first.
Apply a colour fill to the second rectangle.

With the second rectangle selected,
click Weld and with the arrow cursor that appears click on the first rectangle.
You will find the two rectangles have combined into a single object without a fill.

Try this again, this time selecting the first object and welding this to the second.
You will achieve the same shape but this time the new object has a fill.

Trim
Draw 2 rectangles as before. Select one and trim this to the other.
You will find that the target object has a piece missing where the
source object overlapped.

Using the shaping tools automatically converts objects to curves.



The Weld Command

Try this again, this time selecting the first object and welding this to the second.
You will achieve the same shape but this time the new object has a fill.

The Weld command creates a single curve from 2 or more components. 
The components may overlap, sit next to each other or be some distance 
apart.

You are given the option to leave the original
Source object and/or Target object. Checking these tick-boxes
will create duplicate originals. This is useful for advanced users with good 
planning skills and
enables better productivity. It is advised that you leave these
tick-boxes unchecked until you are fluent with using the Shaping
tools. The Source Object is the object you originally select to weld
or trim. The Target Object is the object you subsequently act upon.
It is important to understand that using these tools will affect the
properties of the objects you are working with. The source object
will take on the properties of the target object. The best way to
understand how these tools are used is by example.

Draw a rectangle. Now draw a second rectangle that overlaps
the first. Apply a colour fill to the second rectangle. With the second
rectangle selected, click Weld and with the arrow cursor that appears
click on the first rectangle. You will find the two rectangles have
combined into a single object without a fill.



The Trim Command

The Trim command creates a single curve from 2 or more components. 
The components must  overlap. Trim forms the shape of the selected 
object (Source Object) into the  object you trim to where it overlaps. 
(Target Object). 

You are given the option to leave the original
Source object and/or Target object. Checking these tick-boxes
will create duplicate originals. This is useful for advanced users with good 
planning skills and
enables better productivity. It is advised that you leave these
tick-boxes unchecked until you are fluent with using the Shaping
tools. The Source Object is the object you originally select to weld
or trim. The Target Object is the object you subsequently act upon.
It is important to understand that using these tools will affect the
properties of the objects you are working with. The source object
will take on the properties of the target object. The best way to
understand how these tools are used is by example.

Draw a rectangle. Now draw a second rectangle that overlaps
the first.  With the second
rectangle selected, click Trim and with the arrow cursor that appears
click on the first rectangle.



The Intersect Command

Intersect creates the shape that is formed by the overlap of 2 
components. 

You are given the option to leave the original
Source object and/or Target object. Checking these tick-boxes
will create duplicate originals. 

Draw a rectangle. Now draw a second rectangle that overlaps
the first.  With the second
rectangle selected, click Intersect With and with the arrow cursor that 
appears
click on the first rectangle.

Try intersecting circles with squares

In this example I have Intersected one circle with another then intersected 
this with the third.



The Object Manager Docker

Advanced CorelDRAW users make 
much use of the Object Manager 
Docker. Each item you have 
created can be identified, accessed 
and modified in the Object 
Manager.

New layers can be created in your 
drawing in the Object Manager and 
it allows you to move objects 
between layers and pages. You can 
do this by dragging the item to 
another layer or page. Dragging 
objects within the layer they are on 
will change the order within the 
drawing. 

Each page you create within your 
drawing will appear in the Object 
Manager and selecting objects 
within these pages will 
automatically switch the view to the 
page they are on. You can give 
names to the layers and pages 
here too. Right-click on the layer or 
page and click on rename.

Layers
Layers allow you to manage your 
pages efficiently and productively. 
You can turn on viewing, printing 
and editing of individual layers. An 
example would be in the production 
of a printed carton. Images that are 
to be printed on the carton will be 
created on one layer. A second 
layer is used for the creation of the vector cutting and scoring part of the file. Turn off printing of the cutting 
layer when you are printing the images, reverse this when printing to the laser cutter.

Master Page
Each new file has one Master Page that contains and controls three default layers: the Grid, Guides, and 
Desktop layers. The Grid, Guides, and Desktop layers contain the grid, guidelines, and objects outside the 
borders of the drawing page. The Desktop layer lets you create drawings you might want to use later. You can 
specify settings for the grid and guidelines on the Master Page. See the section on Guidelines for further 
information. You can specify settings, for example colour, for each layer on the Master Page. 

You can add one or more master layers to a Master Page. This layer contains information that you want to 
display on every page of a multipage document. For example, you can use a master layer to place a header, 
footer, or static background on every page.



The Undo Docker

The Undo Docker
This lists the sequence of events that you have made in your drawing and allows you to get 
back to a specific point without losing the work you have done. It is particularly useful for 
teachers as it will let you see how your students have constructed their drawings. You can 
use this to go back to a point in your drawing where you constructed an item and copy this 
item to the clipboard. Then go to the last event and paste the item from the clipboard into 
your drawing again.

If you go back to a previous point and then change something you will lose the other 
work you did from that point on. 

It is important to remember that the number of undo steps available has to be configured in 
the CorelDRAW setup. The default is around 20 steps but you will find this limiting at times. 
If you have a reasonable amount of RAM on your computer I would suggest you increase 
this to around 50 steps or more.



Outlines and Fills

When you create drawings to be cut or engraved on the laser you have to ensure the following 
criteria are applied:

Outlines need to have a line weight of hairline.
They need to have a colour that the laser driver recognises as a command, i.e the precise 
colour as defined in your laser manual.

Filled areas of your drawing can only be engraved.

Outline Fill

We can set the outline colour by 
using the Outline Tool in the Object Properties Docker.

We can set the fill colour by 
sing the Fill Tool in the Object Properties Docker. You will only be able to see and print a fill 

in  a closed path however the object will own fill properties if these were applied. Once the path 
is closed the fill will be visible and can be printed. For information about closing paths refer to 
the section on curve editting.

simply right-clicking on a colour in the colour pallette. It can 
also be set 

simply left-clicking on a colour in the colour pallette. It can also be 
set u

You will have received a CorelDRAW colour pallette with your laser driver. The colours in this 
pallette are the specific colours that the driver recognises and which you can assign tasks for 
the laser to do. This palette needs to be copied to the CorelDRAW palettes folder and opened 
using Window - Colour Palettes - Open Palette then locating the palette from its location.

In the Universal Laser Systems colour pallette there are 8 primary colours and 19 shades of 
grey. The grey colours will apply a percentage of the power you set the black colour to 
corresponding to the percentage of grey you use, i.e. 50% grey applies 50% of the power you 
set for black.



Aligning Objects

As you build your drawing you will find it necessary to arrange components so that they align with 
other components. There is a variety of ways to do this and CorelDRAW has some quick methods. 
Select the objects you wish to align then go to the Arrange dropdown menu  Align and Distribute 
then select the method of alignment you need. Note the shortcuts listed to the right of the options:

L aligns the objects to the left of their bounding box
R aligns the objects to the right of their bounding box
T aligns the objects to the top of their bounding box
B aligns the objects to the bottom of their bounding box
E aligns the objects to the to their centres Vertically
C aligns the objects to the to their centres Horizontally
P aligns the objects to the centre of the page

Remembering these shortcuts will speed up the production of your drawing. Just select the objects 
and press the keyboard character corresponding to the alignment mode.

A few things to note:
All the components you select will be aligned in the same way and this may not be quite what you 
intended. Imagine the example below for a simple keyring. The keyring shape has been drawn, a 
hole for the ring has been drawn and you are ready to place the text to be engraved. 

Solar Laser Systems
01634 290260

www.solarlasers.co.uk

Solar Laser Systems
01634 290260

www.solarlasers.co.uk

Solar Laser Systems
01634 290260
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Selecting everything and aligning them 
centrally will place the keyring hole in the 
centre too. To avoid this happening, first 
group the keyring shape and the hole, then 
align the text on the keyring.

Format text before you align it as formatting 
after will lose the alignment.

Oops!



About Curves

A curve is a series of line segments, each line segment have a node at each end. Line segments can be 
straight or curved and they need not be connected to each other within a single curve.

Curve objects can be modified in different ways to the other objects you create. Each simple shape you 
draw using the tools in the toolbox can be modified in its own particular way. Rectangles can have their 
corners radiused, ellipses can be converted to arcs or pies, polygons to stars etc and text can be edited. 
Converting any of these to curves loses that ability but gives you the ability to infinitely modify the shape 
of the object.

Certain commands automatically convert objects to curves. An example is when using the Shaping 
Docker tools. Converting to curves is a one-way street so make sure your object is exactly as you want it 
to be before you do this. You will not be able to correct a spelling mistake once you convert text to 
curves and the process of changing the radius on a rectangle is much more complicated.

One of the great assets CorelDRAW has is the powerful curve editing capability. This is provided by the 
Shape tool in the Toolbox (Not to be confused with the Shaping Docker tools). See the section on Curve 
Editing for more information.

Shape tool

Node



Curve Editing

We have almost infinite ability to change the shape of the curves we create. The position and type of 
nodes can be controlled, whether the line relating to the node is straight or curved, whether adjoining 
nodes are connected, whether nodes exist at all.

Node editing is achieved with the Shape tool in the Toolbox. You can use this to select the curve you are 
editing, pick up individual nodes and move them around, drag the line segment to change its form, move 
the node control points to alter the form of line segments, add and remove nodes.

There are four node types: cusp, smooth, symmetrical, or line. Nodes can be changed from one type to 
another.

Cusp nodes make the node's intersecting line take on the shape of a corner or point when you adjust 
the position of the node's control points.

Smooth nodes make the node's intersecting line take on the shape of a curve. Each control point can 
be shortened or lengthened independently, giving you smaller or larger angles to work with.

Symmetrical nodes make the node's intersecting line take on the shape of a curve as well as intersect 
the node at exactly the same angle.

Line nodes let you shape objects by changing the shape of their segments. You can make a curve 
segment straight or a straight segment curved.

The more nodes there are in a curve, the greater degree of control is possible with its shape however 
beware of adding too many as this will increase the work your laser has to do and may slow down its 
operation.
Nodes can be added by clicking on the point of the curve you wish to add the node then clicking on the + 
icon on the Property Bar. They can be removed by selecting them and pressing delete, clicking on the  
icon on the property bar or by double-clicking on the node.

Selecting a node and clicking on the Break Curve icon separates adjoining nodes. You can also use the 
shape tool to click on a line segment then click on the Break Curve icon to break the curve at that point. 
If the path has 2 separations it is possible to break the curve apart using the Break Curve Apart 
command in the Arrange dropdown menu. This will produce 2 separate curves.

Selecting 2 adjoining nodes and clicking on the Join 2 nodes icon connects them.

You do not have the ability to define an absolute position for nodes directly but you can get them to snap 
to guidelines or to a grid to achieve this. You can also get their control points to snap to guidelines.
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Combining and Breaking Apart

Terminology that applications use can sometimes be confusing and misleading especially when it is in conflict 
with our usual appreciation of the same terminology. In the case of CorelDRAW a curve for example may 
consist of only straight lines. It may also be comprised of several seemingly separate entities. This can often 
be a difficult concept to grasp because the tendency is to think of these entities as a group. 

Individual components can be combined into a single curve. This provides very useful properties regarding fills 
and editing capability. The process of separating them is called breaking apart. A number of commands we 
apply to our work automatically combine curves and it may be necessary to break these curves apart before 
we can continue editing them.

A simple way of understanding this is to think of text characters. The letter A for example comprises an outline 
shape with a triangle inside. The fill surrounds the triangle but the triangle itself is not filled.

Try the following. Draw the letter A using the text tool. It may help if you enlarge it to a size you can see clearly. 
Convert this to curves (Arrange  Convert to Curves). With the object selected look at the status bar at the 
bottom of the screen. It will tell you it is a curve. Now break the curve apart (Arrange  Break Curve Apart) and 
notice what happens to the fill and what the status bar tells you. We now have 2 objects. Because the triangle 
is a curve in its own right now it has its own fill. Now combine them again (Arrange  Combine) and you will see 
the letter A as before.

A
The ability to control fills in this way has a huge impact on the creativity that is possible when you are producing 
artwork for engraving.

Converted to Curves Broken Apart The individual pieces can be moved



Objects can be combined to create a curve object that has particular properties. A fill only fills 
the gap between the inner and outer parts of the curve. Although the curve is made from 2 or 
more components it is treated as a single curve. An example is shown below.

This curve was created by drawing the heart shape and placing a 
duplicate smaller heart inside. The 2 objects are seleted together and 

combined into a single curve using the Combine command in the 
Arrange drop-down menu. The curve can then be filled. The shortcut for 

Combine is Ctrl + L.

Text can be Broken Apart too. The process works as follows. Paragraphs are broken into 
Sentences. Sentences then have to be broken Apart into Words. Words can be Broken Apart 
into individual Characters. The text is still editable as text but it’s no longer linked to the text it 
was previously part of. Characters that are converted into Curves can be Broken Apart into 
the individual curves that form them, for example the letter B is formed from 3 components.

Tip
Files containing text objects can only be opened 
on other computers having the font that is used 
installed. Converting text to Curves means that 
the text is now a graphical object that can be 
opened on computers that do not have the same 
font installed. Obviously, once text is converted to 
curves it cannot be edited as normal.

This is one curve. It was created by taking the heart shape and 
duplicating 2 smaller heart shapes inside. The 3 shapes were then 
combined so that when filled there is an open area between the 
filled areas of the curve. The open area can be seen in the 
illustration below.

Combining and Breaking Apart Part 2



Convert Outline to Object 

The Convert Outline to Object command can be used to produce solid objects from open curves.

In this example I have drawn a spiral.

Set the line weight to a
given thickness. 

Now set the Convert Outline to 
Object command (Arrange - 
Convert Outline to Object). 
Give the object an outline and 
remove the fill.

Note:
When you convert an outline to an object you still retain the original line. This line is invisible 
but can be located in the object manager and deleted if necessary.

An example of a complete project created using this technique is shown later.



Using Guidelines

Guidelines can be extremely useful tools in the drawing creation process and CorelDRAW gives many options for their 
use.

Simple Guidelines
Simple guidelines can be produced by clicking and dragging the rulers. They can also be produced by entering the 
guidelines setup (View  Guidelines Setup) The left-hand ruler produces a vertical guideline, the top ruler produces a 
horizontal guideline. You can drag them to the rough location you require and you can set them to a precise location on 
the workspace. You can rotate the guidelines, either roughly or to a precise angle. You can create guides from shapes you 
draw and you can snap to the guidelines.

When you create a guideline it will appear as a red dotted line. The property bar will show its position. Entering a value in 
the Object's Position will move the guideline to the location you require. When you deselect the guideline it will appear 
as a faint grey dotted line.

Rotating Guidelines
Selecting the 
guideline and clicking 
on it again will open 
the Rotation 
Handles enabling the 
guideline to be 
rotated at will. If you 
want to set this to a 
precise angle this can 
be set in the Angle of 
Rotation on the 
Property Bar and the 
centre of rotation can 
also be set.

Snapping to 
Guidelines
Snapping to 
guidelines can be 
turned on or off in the 
Property Bar when no 
object is selected or 
go to View  Snap to 
Guidelines if you 
have objects 
selected. Objects can 
be snapped to guides 
at their Bounding Box 
or centre. The edge 
of the object will 
appear as a blue 
dotted line when it is 
snapping.

Creating Guide Objects
Guideline reside in the Guides Layer on the Master Page in the Object Manager Docker.
If you make this layer active, anything you draw will be treated as a guide object. Such objects will not have fill properties 
and will appear as a faint grey outline. You can drag objects from other layers into the Guides Layer. You can of course 
copy objects and then paste them into the Guides Layer when this is active.

Rotation Handles

Centre of Rotation



Dynamic Guidelines

Dynamic guides were introduced 
in CorelDRAW 12 and can 
revolutionise the way you work. 
You will need to turn them on 
either in View - Dynamic 
Guidelines, by using the icon in 
the Property Bar or by 
Alt+Shift+D. They can be 
somewhat unnerving until you 
get used to them as they flash 
up as blue lines when you create 
or move objects relative to other 
objects. It is well worth 
persevering because they will 
improve your productivity once 
you have mastered them.

As you drag an object the 
Dynamic Guidelines will tell 
you if you are moving it 
orthogonally or at a preset angle 
and how far you are moving it.

They will tell you the specific place you are grabbing the object. They will 
automatically snap to other objects and tell you the specific place you are 
snapping to.

You can set the Dynamic Guideline options in View  Dynamic Guidelines 
Setup.



Shortcuts

Many of you will be familiar with Windows shortcut keys. CorelDRAW supports all the usual 
shortcuts and has a number of its own to speed up production. You can also assign your own 
shortcuts to suit your particular working methods. The common shortcuts you are likely to find 
useful with producing drawings for your laser cutter are listed below. As you become familiar 
with the program you are likely to use it for other purposes. A comprehensive list of 
CorelDRAW shortcuts can be found in Tools  Customisation  Commands  Shortcut Keys  View 
All. You can save these to a comma separated text file or print them out.

Ctrl + Z Undo

Shift + Ctrl + Z Redo

Ctrl + C Copy

Ctrl + V Paste

Ctrl + X Cut

Ctrl + G Group

Ctrl + U Ungroup

Shift + PgDn To Back

Shift + PgUp To Front

B Align Bottom

E Horizontally aligns centres

C Verically aligns centre

L Aligns left

R Aligns  right

P Aligns to centre of page

Ctrl + L Combine

Ctrl + K Break apart

Moves selection up by defined nudge

Moves selection down by defined nudge

Moves selection left by defined nudge

Moves selection right by defined nudge

Shift + Moves selection up by Super nudge factor

Shift + Moves selection down by Super nudge factor

Shift + Moves selection left by Super nudge factor

Shift + Moves selection right by Super nudge factor

Ctrl + Moves selection up by Micro nudge factor

Ctrl + Moves selection down by Micro nudge factor

Ctrl + Moves selection left by Micro nudge factor

Ctrl + Moves selection right by Micro nudge factor



Box Project 1

So let’s apply the techniques we’ve covered so far
and use them to create a jointed box.
Step 1
Draw a rectangle.

Step 2
Size the rectangle to 10mm long by 3mm tall

Step 3
Select the rectangle and using the Relative positioning tool
enter 20mm and click Apply to Duplicate 3 times

Step 4
Uncheck the Relative tick-box and click the bottom centre radio button.
Select the 5 rectangles and enter a value of H:0.0 and V: 0.0 and click Apply.



Box Project 2

Step 4
Draw another rectangle and set the size to be 70mm x 64mm

Step 5
Set the anchor point in the position tool to be the top centre.
Enter a value of H: 0.0 and V: 0.0 and click Apply



Box Project 3

Step 6
Select the 4 small rectangles and copy to the clipboard (Ctrl=C) or Edit - Copy
In the Shaping Docker click Weld and touch the arrow cursor on the large rectangle.

Step 7
Using the Rotate tool, enter a value of 180 degrees and click Apply.
Now position the top centre of the object to H: 0.0 and V: 0.0

Step 8
Paste the 4 rectangles held on the clipboard and Weld these to your object



Step 9
Using the Rotate tool, enter a value of 90 Degrees and click Apply.
Position the top centre to H:0.0 V:0.0 and click Apply
Draw a rectangle and set the size to  H:40mm and V: 3mm
Position the top centre to H:0.0 V:0.0 and click Apply

Step 10
Copy this to the clipboard then Trim it to the other object.

Box Project 4



Box Project 5

Step 11
Rotate the object 180 degrees
Paste the rectangle from the clip board and Trim this to the other object.

We have now completed 1 side. The opposite side will be identical.
Move the object away from the zero-zero point ready for the next part.



Box Project 6

Step 12
Create 4 rectangles as we did in Steps 1 - 4 and position them so that the top centre is at H: 0.00 V: 0.00
Create a rectangle and set the size to be 70 x 70mm
Position this rectangle so that the top centre is at H: 0.00 V: 0.00

Step 13
Select the 4 smaller rectangles and copy these to the clipboard
Trim these to the larger rectangle



Box Project 7

Step 14
Rotate the object 180 degrees, copy the rectangles from the clipboard and Trim these to the other object.

Step 15
Rotate the object 90 degrees.
Create a rectangle and set the size to be 40mm x 3mm.
Position this rectangle so that the top centre is at H: 0.00 V: 0.00



Box Project 8

We now have a joint for the base

Step 16
Rotate the object 180 degrees.
Paste the rectangle from the clipboard and Trim this to the other object.

We now have a side that will joint into the first side we made.
Again, the opposite side will be identical.
Move this piece out of the way ready for the top and bottom pieces



Box Project 9

Step 17
Create a rectangle that is 40mm x 70mm
Position this so that the Centre is at H: 0.00 V: 0.00
Rotate 90 degrees THIS TIME CLICKING Apply to Duplicate

Step 18
Weld the second rectangle to the first.



Box Project 10

Step 19
Create a rectangle that is 64mm x 64mm
Position this so that the Centre is at H: 0.00 V: 0.00

Step 20
Weld the rectangle to the other object.

We have now completed the top piece.



Box Project 11

Step 21
All that remains now is to position the 3 pieces we have drawn so that they are aligned with 
each other and duplicate them.

Position the parts within your graphic where you wish them to be cut and save your graphic.



Creating Clock Face Numerals

Using the Text tool, c  and with the font Centre Justified type 12.

Position the text at H: 0.00 and V: 100.00

In the Rotate tool enter a value of 30 deg, set the Centre of Rotation to be H: 0.00 and V: 0.00 
then click apply to Duplicate 11 times.

hoose your font

Now select each number in turn 
and in the Text drop-down 
menu choose edit text and 
modify the text to be the 
number required for its position 
on the clock face.

The numbers can be rotated 
relative to the position each has 
by checking Relative Centre in 
the Rotate tool, set the anchor 
point to be in the centre and 
with the Angle set at 30 deg 
click Apply a number of times 
until the number is viewed 
correctly.

Select all the numbers and group them. The Group command is in the Arrange drop-down 
menu but you can also use Ctrl + G as a shortcut. The clock face numerals can now be 



Using Text Creatively

CorelDRAW refers to 2 different text modes: Artistic Text and Paragraph Text. They are used for 
different purposes.

Artistic text can be used for small amounts of text and is generally simple to manage. It can be 
used to follow a path around a shape, or be manipulated using the extrude tool etc.

Paragraph text is used for large bodies of text and is used creatively to have the text flow around 
or inside objects. It can be linked to other text boxes that work interactively with each other.

i icd ema   l             p f  l  a ot a n  s  ns  e  db         m 
e eh nT

To all the girls I 
loved before, that 

wandered in and out my 
door, I’m glad they 

came along, I 
dedicate this 
song to all 
the girls I 

love

Getting text to 
flow around 
shapes is 
achieved by 
setting the text 
wrapping properties of 
the objects the text has to 

flow around.

To get text to follow a path 
you can simply type the text 
then select it and click on Fit 
Text to Path in the Text drop-
down menu.

Text can be fitted within an object in the following 
manner. Draw the frame for the text then Unig the text 
tool hover over the edge of the frame. You will see the 
cursor change to this        or this.

AB

A

AB

A

This cursor is used to fit the text within a frame. When 
you get this cursor click and start typing.

This cursor will automatically fit text to a path around the 
object. It is not necessary to use the Fit Text to Path 
command if you use this option just click and start typing 
when you get this cursor.

To link text from various text boxes, click on the square at the top of 
the text box. Now click on the text box this needs to be linked to.

If the at the bottom of a text box contains a black inverted arrow like this,
it is telling you there is an overflow of text in this text box. You will either need to make 
the text box larger of link the text box to another that can take the overflow. 

select the text then 



Importing into CorelDRAW

CorelDRAW supports the import and export of many different file-types. Files can be imported 
using the Import command in the File drop-down menu or by clicking on the Import icon on the 
Standard toolbar. You can also drag files from Windows Explorer into CorelDRAW to import 
them or you can copy objects from other applications and paste them into CorelDRAW.

Import Export

Graphics that have been imported into CorelDRAW will be grouped 
so if you intend to modify them you will need to ungroup them first.

Although CorelDRAW does its best to keep up with the files other 
applications produce, these are constantly being revised. Corel’s 
import filter  is usually one or 2 versions behind the files other 
applications produce. If you experience difficulty with importing, try 
saving the file as an earlier version.

Graphics from other applications will be imported as curves however they may not always have 
their nodes joined, it depends how the application that created the graphic works. Generally, 
polyline objects have connected nodes. If the nodes are not joined you will not be able to apply 
a fill to the object.

The most common export option for graphics packages is DXF format. It is also the most 
tedious and unreliable to work with. When you import a DXF file into CorelDRAW you are given 
the option to select the units (either Inches or Metric) you wish the file to be imported with. In 
some instances you will need to ensure the application that the file was exported from was set 
to the units you will be importing as well.

DXF files sometimes have components rearranged when they are imported. This usually 
occurs when the files are particularly large. You should check the file looks like it did before it 
was imported before proceeding.

Sometimes DXF files have additional lines and nodes. CorelDRAW gives you the option of 
automatically reducing nodes when you import to reduce this.

Some applications treat circles as a series of straight lines rather than a circle. The number of 
lines that comprise the “circle” are a function of the application that created it, in some 
instances this can be setup in the application but regrettably not always.



Tracing Basics 1 of 3

Step 1 >>
Lighten your image,
using the arrow (pick
tool). Then click on
effects > adjust > 
brightness/contrast/
and set the settings to
Brightness: 30
Contrast: -40
Intensity: 0
Then press OK! 

Step 2 >>
Click on the small arrow
to get the menu to fly 
out then click on the
polyline tool. (Note: to 
zoom in and out simply
roll the mouse wheel).

Step 3 >>
Using the polyline tool
roughly trace the shape
from your image, then
double click when you
reach the end this 
closes the line. (Note:
if you don't the line will
keep on going!)

Watch the detailed tutorials to learn more at:  
http://www.lanfrancdt.co.uk/software/coreldrawtracing.htm



Tracing Basics 2 of 3

Step 4 >>
Now we need to increase
the line thickness and 
colour so we can see it.
Using the arrow (pick tool)
click on your line. Next
double click in the
corner of your screen on 
the outline colour (the
rectangle next to the small
pen). Set your colour to
red and your line width to
something thicker then
press ok!

Step 6 >>
Now click on the shape
tool and draw a box
around the whole of your
shape. This will let you
curve, smooth and cusp
all nodes on the line
instead of one by one!

Step 7 >>
Now you will see options
at the top of the screen.
Click on 1. Convert line
to curve, then 2. Make
node smooth, then
3.Make node a cusp. You
will now be able to easily
curve the lines.

Watch the detailed tutorials to learn more at:  
http://www.lanfrancdt.co.uk/software/coreldrawtracing.htm

1 23



Tracing Basics 3 of 3

Step 8 >>
Now select the arrow
and click away from the
shape to unselect it. Next
select the pick tool and
click on your shape then
click on a node on your
shape. You will now see
two handles appear from 
your node.

Step 9 >>
Now drag the nodes
handles to create any
curve you wish. Now 
shape your line to fit
the image your tracing.
Now trace your whole
image.

Want to know more about Corel Draw?

On the same page as the tutorial is a Corel manual. It is the last link on
the page. Or use the direct link below:

http://www.lanfrancdt.co.uk/websiteprintablepdfs/HowtouseCorelDRAW.pdf

The manual tells you much more about Corel and the many things it can
do. Have fun with Corel Draw and get learning!

Watch the detailed tutorials to learn more at:  
http://www.lanfrancdt.co.uk/software/coreldrawtracing.htm



Rendering 1 of 2

Step 1 >>
Using the arrow click on the
part of the drawing you wish
to render. Then click on the
colour you wish it to be from
the colour panel on the right. 

Step 2 >>
Next click on the fill tool then
click on the fountain fill tool. 
The fountain fill window will
then open.  

Step 3 >>
Now click on the custom
button and a custom 
colour bar will appear. Now
click on an arrow then pick 
a colour and the bar will
change. Double click
anywhere on the bar to 
add a new colour. You can
also drag an arrow this 
helps you blend the colour.
Note: you can choose a
radial blend or a linear 
blend under type at the top. 

Learn more about corel draw here:  
http://www.lanfrancdt.co.uk/software/coreldraw.htm



Rendering 2 of 2

Step 4 >>
Here you can see i have 
added several blends to make
up my render. Once done 
press the ok button to apply
it to your drawing. 

Step 5 >>
Right click on your rendered
shape, then select styles and 
choose the save style 
properties option and enter a
name for your style i called 
mine blue1. Now right click
on an un-rendered shape and
choose styles, then choose
apply and pick the styles name
you just saved. This will add the
same style to the other shape. 

Step 6 >>
Now create more styles and add
them to your shapes. Also try
the other render options from the
fill tool menu try pattern and 
the texture options. 

Learn more about corel draw here:  
http://www.lanfrancdt.co.uk/software/coreldraw.htm
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